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(MS WINDOWS 7, MS OFFICE 2007-2010-2013)

CAU HOI LY THUYET PHAN KIEN THUC CO BAN MAY TIiNH

. Hé thong nhd cia may tinh bao gom:
a. B§ nhd trong, Bé nhd ngoai
b. Cache, Bo nhad ngoai
¢. B nhd ngoai, ROM
d. Dia quang, BS nho trong

. B nhd ngoai cua may tinh thuong la:
a. Dia ctimg, ROM. dia CD, thiét bi nhé Flash (USB).
b. Bia CD, dia cang, ROM, RAM
¢. bia mém._ dia CD, RAM, dia cling
d. Cac céau trén déu sai.

. Chir »:iét tét MB thuong duogc dé cép trong hé théng tin hoc ding dé do:
a. Toc do xua ly b. Kha ning luu trir
¢. Mirc dé dm thanh d. Khéng do gi

. Nhom thiét bi ra:
a.Man hinh, may in, chudt, may quét
b. Mdy in, loa, ban phim, man hinh
c. Man hinh, loa, tai nghe, may chiéu
d. Mdy in. may chiéu, ban phim, loa

. Chon phat biéu ding:
a. RAM la Random Access Memory
b. ROM la Random Only Memory
c. RAM la b nhé chi doc
d. ROM 1a bd nh& truy cap ngdu nhién

. Con $6 400 GB trong hé¢ thong may tinh ¢6 thé la:
a. Téc 46 xur 1y cia CPU
b. Téc dd xur |y cua dia cirng
c¢. Pia cliing cé dung lugng 400 GB
d. y a,b hodc ¢ déu dung

. Phat biéu nao sau diy vé RAM la dang
a. RAM co thé dac va ghi dir lidu
b. RAM cé dung luong lén hon dia ciing
¢. RAM c6 chirc nang gidng nhu ROM
d. RAM chi cho phép doc dir li¢u

.CPU la:
a. Mach dién t&r nho bé ciia may tinh
b. Phan mém quyét dinh cde budc thao tic ciia may tinh
¢. Central Processing Unit
d. Control Processing Unit.

. Nhém thiét bj vao: ,
a. Ban phim, may quét, may chiéu; Webcam
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b. Chudt, ban phim, Webcam, may quét
¢. May quét, tai nghe, ban phim, micrd
d. Webcam, micrd, loa, ban phim.

10. Chon th(r tu ting dén khi sip xép céc don vi do thong tin:

a. KB, GB, MB,TB h. MB, TB, GB, KB
¢c. KB, MB, GB, TB d. TB, GB, MB, KB
11. Chon thir tu giam dan khi sap xép cac don vi do thong tin:
a. Gigabyte, Megabyte, Kilobyte b. Megabyte, Gigabyte. Kilobyte
¢. Gigabyte, Kilobyte, Megabyte d. Kilobyte, Megabyte, Gigabyte
12. Don vi do toc do xir li cua CPU 14 :
a. MB (Megabyte). b. GB (Gigabyte).
c. KB (Kilobyte). d. MHz (Megaheriz) hoiac GHz (Gigahertz).

13. Phim nao sau day thudng duoc sir dung cung lGc voi cac phim khac dé thuc hién mot chirc nang

nao dé
a. Phim Alt b. Phim Caps Lock
¢. Phim Insert d. Phim Tab
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TRAC NGHIEM WINDOWS

14. Chon phat biéu diing. Trong Windows Explorer:
a. Tao dugc Shorteut trong cua ) Explore.
b. Tao duoc Shortcut trén man hinh desktop.
¢. Tao duge Shorteut trong ctra s6 Explore va trén man hinh desktop.
d. Céc cu trén déu ding.

15. Mudn x6a chuong trinh trong Windows, ta thuc hién:
a. Vao Control Panel tim va thuc thi céc 1énh lién quan dén Hardward
b. Vao Control Panel tim va thuc thi céc lénh lign quan dén Programs.
¢. X0 biéu tuong trén man hinh Desktop
d. Céc cau trén déu sai

16. Mubn thay ddi dang s trong Windows ta vao Control Panel tim va thuc thi cac Iénh lién quan dén:
a. Date/Time. b. Region. c. Fonts. d. System.

17. Trong Windows Explore hién thi tap tin dang chi tiét(co ngay, gid. kiéu) sir dung menu:
a.View/List. b. View/Details.
¢.View/Small [cons. d. View/Large lcons.

18. Chon phét biéu dang. Trong Windows:
a. Khong thé dbi tén tap tin c6 thude tinh luu tri.
b. Khong thé xoa tdp tin ¢6 thude tinh chi doc.
c. Khong thé thay dbi ndi dung cia tép tin ¢6 thude tinh chi doc.
d. Cau a. b, ¢ sai.

19. Chon phat biéu dung. Hé diéu hanh Windows la:

a. Hé diéu hanh da nhiém b. Hé diéu hanh c6 giao dién dd hoa.
¢. Cau a, b dung. d. Céu a, b sai.

20. Nit mang ddu trir trén thanh tiéu dé c6 chirc nang;: )
a. Phuc hoi lai cua s do. b. Cuc tiéu hoa cia s6 vé Taskbar.
¢. Dong cura sb do. d. Phong to cuc dai cua so do.

21. Trong hé diéu hanh Windows, cong dung cta phim Print Screen li gi?
a. In man hinh hién hanh ra may in.
b. Khéng cé cong dung gi khi st dung | minh no.
¢. In van ban hién hanh ra may in.
d. Chup man hinh hién hanh.

22. Mubn phuc hdi cdc tap tin, thu muc bi x6a trén dia cing, ta thuc hién:
a. Ma Windows Explorer, vao File chon Restore.
b. M& Recycle Bin, chon céc tap tin thu muc mudn phuc héi, vao File chon Restore.
c. Mé Windows Explorer, vao Edit chon Undo delete.
d. Md Recycle Bin, vao File chon Restore.

23. Thanh phén nao khong thudc ctra s6 Windows Explore:
a. Thanh tiéu dé. b. Thanh cong cu.
c¢. Thanh trang thai. d. Con tro chudl.
24, Chon cau sai. Trong Windows:

Trang 3
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a. Co thé tao duge thu muc va tap tin trong | thu muc.

b. C6 thé tao thu muc trong tap tin.

¢. Khéng thé thay ddi ndi dung clia tap tin cd thudge tinh chi doc.
d. Ca thé di chuyén 1p tin ¢6 thuge tinh luu triv.

Trong Windows, tap tin cd thude tinh chi doc (read only). thi khdng thé :
a. Xda b. Thay doi noi dung.
¢. Di chuyén d. Cédc cau trén déu ding
Trong Windows Explore dé ddi tén thu muc. tap tin duge chon, ta thuc hién :
a. Click phai chudt\chon Rename b. File\Rename
¢. Nhin F2 d. Cau a, b, c ding,
27. Chuong trinh nao sau day co thé dung dé giai nén tap tin, thu myc:
a. WinZip b. WinRAR
c. Ciu a va b déu sai d. Caua va b déu ding,

. I'rong thu muc A ¢é thé chira:

a. Thu muc GiaiThich va tap tin Giai?thich.txt

b. Thu muc ?TaiSao va ap tin TaiSao.txt

¢. CAc cau a va b déu sai.

d. Cac cdu a va b déu ding

Pé tao thu muc trong Windows, ta thuc hién click phai chudt tai noi can tao, chon:

a. Propertics. b. Refresh.
¢. New\Folder. d. Cdua, b, c sai.
Trong mdi rudng Windows ta cd thé chay cing lae:
a. Hai chuong trinh. b. Chay nhiéu trinh (g dung khac nhau.
c. Chi chay mdt chuong trinh. d. Ciu a, b, c sai.
‘I'rong Windows la cd thé tim kiém tap tin:
a. Theo kich thude b. Theo ngay thang tao lap.
¢. Theo kiéu tdp tin. d. Cdc cau trén déu dang.
. Trong Windows, dé x6a han ap tin, thu muc (khdng bo vao Recycle Bin) ta dung td hop phim:
a. Ctrl — Delete. b. Alt — Delete.
¢. Shift - Delete. d. Tab — Delete.

Mudn cai thém font maéi trong windows. ta thuc hién:

a. Viao Control Pancl, tiép tuc tim va thuc thi cac [€nh lién quan dén Fonts dé thém.
b. Vao Control Pancl tim va thue thi cac 1&nh lién quan dén Programs

¢. Vao MS Word chon menu Format\J-ont.

d. Céc cau wén déu sai.

Trong Windows, mang ngang hang (peer to peer network) con dugc goi la:

a. Group b. Domain.

¢. Network d. Workgroup.

. Trong Windows, mubn khai ddng Windows Explorer, ta thyuc hién:

a. Click phai trén Deskiop, chon Explore

b. Click phai chudt wén My Computer\Explore.

¢. Click phai vao nat Start, chon Explore.

d. Cau b va ¢ dung.

I'rong Windows, dé chon ché do Screen Saver cho man hinh:

a. Click phai chudt 1én Desktop\chon Propertiesichon Screen Saver.
b. Click Start\chon Settings\Control Panel\Display\Screen Saver.

¢. Ciu a. b dang.

d. Ciu a, b sai.

. Trong hé diéu hanh Windows dé thuc hién chong phén manh dia, ta thuc thi chuong trinh:

a. Disk Cleanup. b. Disk Defragmenter.
c. System Restore. d. Cau a. b, ¢ sai.

Trang 4
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38. Hay chon cdu sai

TRAC NGHIEM PHAN MS WORD
a.Ctrl-0: Ma tai liéu b. Ctrl-N : Md tai liéu tréng
¢.Ctrl-T: ch@r nghiéng d. Cul-B : Chaor dam
39. Trong MS Word sau khi khéi doan van ban rdi bim giir chudt va kéo di. két qua la:
a.X0a doan vin ban do
¢.Sao chép thém doan vin ban mai

b. D&i dogn van ban dé sang vi tri moi
d.Khdng ¢o tac dung gi ca
40. Trong MS Word sau khi khéi doan vin ban rdi nhin Ctrl-X thi:
a.Xo6a doan van ban do

b. D&i doan van ban dé sang vi trf méi
c.Sao chép thém doan van ban mdi  d.Xoa doan vin ban dé va luu vao clipboad
41 Irong MS Word, ta bo dau tiéng vidt khong duoe c6 thé do:
a. Khéng c6 chuong trinh gd tiéng vict. b. Chon kiéu go tiéng viét khéng pht hop
¢. Chon bang ma khong pha hop. d. Cac cdu a, b, ¢ ding.
42. Font dang chon 1a Tahoma, ta phai chon bd ma nao dé co thé o duoc liéug Viét
a. TCVN3
¢. UNICODE

b.VNI WINDOW
43. Trong Microsoft Word dé chon tit ca van ban ta thuc hicn:
a. Cul - A.

d.UTF-8
b. Ctrl - C.
c. Ctrl = V. d. Ctrl - X.
44. D¢ dua con (ro van ban vé dau van ban hién hanh, ta thuc hién:
a. Ctrl + Home,
c. Home

b. Ctrl + End
d. End

45. Trong MS Word dé chuyén nhanh sang chir thudng hodc in hoa, ta sir dung t6 hop phim:
a. Shifi-F2, b. Shift-F3.
¢. Shifi-14. d. Shift-F35.
46. Chon nhom phim dung trong soan thao van ban dé di chuyén con tro

a. Home, End, PageUp. Page Down b. Céc phim F1 dén F12

c. Caps Lock. Num Lock, Scroll Lock d. Shift, Alt, Ctrl
47 DE dua con tro van ban vé cudi dong hién hanh, ta thue hién:

a. Ctrl + Home b. Ctrl + End
c. Home d. End.

48. "Irong MS Word, st dung phim F12 ding dé

a. DOi chlr thudng thanh chir IN HOA.

c. Luu i liéu dang soan thao véi tén khac.,

b. Phéng to cira s0.
d. Khéng lam gi ca.
49. Trong Word, gia st ban da danh dau mot khoi van ban trong vin ban dang soan thao, néu muén
a. Ctrl + V
c. Ctrl + X

luu nd vao trong by nhd dém va khong con thay né trén man hinh. chon lénh:

b. Ctrl +C
d. Cul+ Z
50{' . i Page | Sec 1 11 At 1 il Gl
IHinh sau diy cho biét: - ,

a. Vin ban co | trang

c. Khéng ¢o ¥ nghia gi hét

b. Vin ban cé | trang, trang hién hanh la trang |
d. Vin ban dugc danh sé trang 1a |
51. Trong Microsoft Word dé chuyén déi ché do ghi deé ta gd phim
a. Ctrl b. Alt
c. Delete d. Insert
52. Khi cin phuc hdi thao tac trude do ta diing 14 hop phim:
a. Cul -+ F b. Ctrl + E
c. Cul+ S d. Curl + %2
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53. Trong Word cdng cu Justify dé cang ky tu (canh [€) theo:

a. Lé trai b. L& phai
c. Canh gilra d. Déu hai bién
54.Trong dinh dang van ban, mudn chon kiéu chir gach chan, ta sir dung phim néng:
a.Ctrl+B b. Ctrl + 1
c.Ctrl+ U d.Ctrl + A
55 Trong MS Word, t6 hop phim Ctrl-] dung dé :
a. Giam | ¢c@ chir. b. Tang 1 c& chir.
¢. Tang 2 ¢d chir. d. Giam 2 ¢ chi.
56 Trong MS Word t6 hop phim Ctrl _Shift = dung dé dinh dang :
a. Chi s6 dudi (hé s6.. b. Chi sb trén (s6 mii).
¢. Khong lam gi ca d. Céu a, b c sai.
57 Trong MS Word dé dinh dang Font chit in ddm. ding 16 hop phim:
a. Ctrl - B b. All—B
c. Ctrl -1 d. Alt—1
58.Trong MS Word dé lam chir rdng ta ding chirc nang:
a. Shadow b. Outline
¢. Emboss d. Engrave
59.Trong Word, mudn chén vao vin ban cic ki tr dac biét nhu p, @, ... ta chon:
a. [nsert/Comment b. Insert/Footnote
c. Insert/Caption d. Insert/Symbol
60.Trong MS Word, ta ¢c6 thé thuc hién dugc:
a. Lam 16n ky tu dau tién cua Paragraph. b. Binh dang dong van ban.
¢. Chén hinh anh wr tap tin trén dia USB. d. Cdu a, b, ¢ ding.
61.Trong Microsoft Word dé xudng dong ma khang ngit Paragraph, ta thuc hi¢n:
a. Nhan t6 hop phim Ctrl-Enter. b. Nhén t6 hop phim Alt-Enter.
¢. Nhén t6 hop phim Shift-Enter. d. Cau a, b, c sai.
62.Trong MS Word, chirc nang Dropcap dung dé:
a. Tao bang biéu. b. Ddi chir thuong thanh chir in hoa.
c. Lam 16n ky tu dau doan vén ban. d. Cdu a, b, ¢ sai.
83. Trong MS Word, biéu tuong Format Painter trén thanh cong cu diing dé:
a. Té nén cho doan van ban. b. Sao chép dinh dang.
c. Chén cong cu vé hinh. d. Céc ciu a, b, c sai.
64. Trong MS Word dé ngét ¢t cho doan van ban (¢6 chia cot), ta sir dung t6 hop phim:
a. Ctrl + Shift + Back b. Shift + Enter
c. Ctrl + Enter d. Ctrl + Shift + Enter
65. Trong MS Word chirc nang Page break ding:
a. Ngit cdt van ban b. Ngit dong van ban
c. Ngat trang van ban d. Ngét doan van ban
66. Trong Word, mudn danh chi sb tu dong & dau dong cho cac doan vin ban, ta sir dung chiic ning:
a. Format/Paragraph b. Change Casc
¢. Borders and Shading d. Bullets and Numbering
67. Trong Word, mudn danh sé trang tu dong , ta chon :
a. Format/Paragraph b. Format/Page numbers
¢. Insert/Page numbers d. Insert/Paragraph
68. Trong Word, mudn in van ban dang mo, ta su dung phim noéng:
a. Ctrl + 1 b. Ctrl + P
c.Cul +O d. Ctrl +N

69. Trong Word dé in trang hién hanh cta vin ban dang mé thi nhin nat 1énh Ctrl - P, sau dé chon
vang in la :
a. Pages b. Current Page
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c. All pages d. Cau b va ¢ dung
70. Trong Word, mudn thiét lap trang in theo chiéu ngang, ta chon :
a. Portrait b. Landscape
c. lop d. Bottom
71. Trong MS Word, bang biéu co thé :
a. Chia mdt bang biéu thanh hai bang. b. Chia m&t & thanh hai 6.
¢. Cédu a, b ding. d. Céu a, b sai.
72. Trong MS Word, bang biéu ¢ thé :
a. Nhap hai bang biéu thanh mét bang. b. Nhidp hai 6 thanh mot 6.
¢. Cau a, b dang. d. Cdu a, b sai.
73. Trong MS Word dé thém mét hang ndi dudi vao bang, ta dinh vi trd vao 6 cudi cung roi g0 phim:
a. Insert b.All
c.Ctlr - Tab d. Tab
74 Trong MS Word, chitc ning Merger Cells diing :
a. Nhép cac bang biéu thanh mot bang. b. Nhap cdc 6 thanh mat 6.
c. Cau a, b dung. d. Céu a, b sui.
75. MS Word, chire nang Split Cells ding :
a. Tach mot bang biéu thanh nhiéy bang. b. Tach mét 6 thanh nhiéu a.
¢. Cau a, b ding. d. Cdu a, b sai.
76. Trong MS Word dé chén hinh, ta chon:
a. Format\Picture b.Insert\Picturce
c. Insert\Symbol d.File\Picture
77 ‘Trong MS Word dé tao chir nghé thudl, ta st dung chirc ning (hodc cong cu) lién quan dén:
a. Object b. WordArt
c. Print d. Symbol
78.Irong MS Word chirc nang Mail Merge ding dé
a. Chén hinh b.Tron thu
c.Tao chit nghé thudt d.Tao dd thi

79. Trong MS Word chire nang nao cho phép chén ngay gio vao vin ban

a. View/Date and Time b. Edit/Date and Time
¢. Format/Date and Time d. Insert/Date and Time
80. Trong MS Word. khéng thé thue hién duoc:
a. Tinh Lodn. b. V& hinh.
c. Quay phim. d. E-Mail.
81. Hay chon ciu sai
a.Trong MS Word khéng thé tinh todn b. Trong MS Word khong thé quay phim
c. Trong MS Word ¢6 thé v& hinh d. Trong MS Word cé thé sir dung E-mail
82. Trong MS Word dé lam ki tu dic biét(Symbol. 16n 1¢én thi:
a.Bam chudt vao 2dc va kéo ra b. Khdi ki tr roi chon ¢d chiv (Size) I6n
c.Khong lam lon 1én duge d.Ciu ava b dang

Trang 7
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CAU HOI EXCEL

83. Biéu thire sau cho két qua la gi: =Max(2.3.7.9.¢)

B2 b. 9

c. fiName? d. #Value!
84. Trong Excel, biéu thirc sau tra lai két qua la i =Sum(A1:A3)

a. Tong céc sb trong cac & Al, A2, A3, A4, AS
b. Téng 2 sd trong & Al va A3
¢. #Name?
d. #Valuc!
85. Trong MS Excel, cho biét gia tri cua cdng thirc sau dy: =MIN(MAX(57.2)+7)
a.9 b. Cong thirc c6 16i
o d. Cau a, b, ¢ sai.

86. Cac tap tin bang tinh Excel c6 phén kiéu (phan mé rong) 1a :

a. EXE, EXEX b. DOC,DOCX
c. DAT.DATX d. XLS, XLSX
87. Trong MS Excel, dé tao mdi bang tinh ta sir dung 16 hop phim:
a. Curl-Shilt-N. b. Ctrl-N.
c. Ctrl-A. d. Ctrl-O.
88. Trong MS Excel, dé luu thém bang tinh véi 1€n mai ta ¢o thé :
a. Strdung t6 hop phim Ctrl-S. b. Vao menu File\Save As.. ..
¢. Strdung t6 hop phim Alt-S. d. Vao menu Edit\Save As....

89 Trong MS Lxcel d¢ chon viing 8 roi rac:

a. Ding chudt chon trong khi gio phim Shift.

b. Dime chudt chon trong khi gitr phim Al

¢. Dang chudt chen trong khi gitr phim Ctrl.

d. Diing phim lab di chuyén va click chudt chon.
90.Trong MS Cxcel dé chon ving 6 lién tuc:

a. Dung chudt chon trong khi gili phim Shift.

b. Ding chudt chon trong khi gitt phim Alt

¢. Dang chudt chon trong khi gitr phim Crrl.

d. Cau a. b.e dang.
91. Trong MS Egu:cl chi co dia chi ¢dt duoe thay déi, con dia chi dong ¢ dinh khi & chira cong thirc
duge sao chép dén vi tri & khac, thi goi la dia chi gi?

a. Dia chi twong déi. b. Dia chi tuyét déi.

c¢. Dia chi tuong d()l L, tuyét déi dong. d. Dia chi tuyét ddi ¢ot, tuong dbi dong.
92. Trong MS Exccel, dé xo0a han | dong khai bang tinh:

a. Chon dong c¢én xoa rdi nhin phim Delete.

b. Chon dong cén xoa, click chudt phai roi chon Delete.

¢. Cach a va b déu ding.

d. Cach a va b déu sai.
93, Trong MS Excel, thao tac xoa nhu hinh v& s&:

[ Delete £l %D

- Entire row

. Enfire golumn

ok ) (e ]|
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a. Xoa cac 6 duoc chon va cac o dir liéu tiép giap bén trai s& doi sang.
b. Xod cac & duge chon va cac 6 dir liéu tiép giap bén phai sé doi sang.
c. Xoa dong hién hanh.

d. Xoé cdt hién hanh.

94. Trong MS Excel, khi nhén t6 hgp phim Ctrl-Home ¢ nghta I

a. Chuyén vé 6 dau tién cua bang tinh (& Al). b. Chuyén vé & cudi cling cia bang tinh
¢. Chuyén vé 0 dau dong. d. Chuy¢n ve 0 cudi dong.

95, Trong MS Excel, khi nhan phim Home ¢6 nghia la
a. Chuyén vé 6 dau tién cia bang tinh (6 A1).  b. Chuyén vé 6 cudi cling ctia bang tinh

¢. Chuyén vé& 6 dau dong. d. Chuyén vé & cudi dong.
96. Trong MS Windows, dé dinh lai cdch nhdp ngay thang trong phin mém Excel, ta vao :
a. Control Panel \ Add Hardware. b. Control Panel \ Date and Time.
¢. Control Panel \ Display. d. Control Panel \ Regional and Language.
97. Trong cdng thirc cua Excel, dé nhap toan tir luy thira (s6 mil) ta ding :
a. T6 hop phim Ctrl_Shift_=. b. Té hop phim Ctrl_—.
c. Phim ~ . d. Khéng co toan W nay.
98. Cong thire $A3+8B3 tai 6 C2 khi duge chép sang 6 D2 s& c6 dang la:
a. Ad + 13 b. A3 + B4
c. A3+ B3 d. $A3 + 35133
99. Bdn loai toan tr ma Excel st dung 1:
a. S& hoc. chudi, so sanh, tham chiéu. b. S& hoc, dai s6. so sanh, tham chiéu.

¢. S6 hoc, dai sd, biéu d. so sanh. d. Dai sb. chudi, biéu dé. tham chiéu.

100. Trong Excel, todn tr %" la :

a. Phép chia ly s6 du. b. Phép chia lay phin nauyén.
c. Phép toan “phin tram”, d. Khdng ¢6 Loan L nay.

101. Trong Excel, cdp todn tar <" =7 lién ké nhau dang “<>"la:
a. Cho biét gia tri “nim trong khoang™. b. Toan i so sanh “khac nhau™.
¢. Thay cho todn tir =", d. Khéng siv dung duoc.,

102. Gia str & Al=-3.2. Cong thue Int(AT) ¢6 gia tri [a bao nhiéu?
a. -4 b.-3
e -2 d 3

103. Trong lxcel. dé tinh & ThuéGTGT 1a 10% cia DG (PG 1a gia tri hodc dia chi cia 6 chaa gia tri
Pan Gia). ta nhip cong thire sau:

a. =10% * DG b.=10/100 * DG
c. =0.01 * BG d. Caa, b, ¢ déu ding .
104. Cho bang tinh sau:
A T B cC__j b [ E
] su Mahang | Sdluong | Dongia | Thanhtien |
7 i' TH T T 3 _ uen
3 g H2 | 33 130
4 | .. ] B
Cong thire xac dinh @i tri c6t thanh tién (Sé luong * Pon E:Ta&t 06 E2 la:
a. C$§2+8D2 b. C$2*D$2
¢, C2*D2 d. SC$2*$D§2

105. Bicu thire sau cho két qua 1a gi
- rabede™ - Tede”
a. Bdo 10} b.
c. 3 d."ab”

(]
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106, Gid it 6 A1 ¢6 gid tri s6 132, 6 A2 c6 gi tri s 14 3. Biéu thirc sau cho két qua Ia gi ?

~ Al&AZ
a. Bao 161 b.5
c. Giatrisd 23 d. Chudi ky tu “23”
107. Biéu thie sau cho két qua la bao nhiéu?
=Mod(8/3)
a. | b. 2
€3 d. Bao 15
108. Biéu thirc sau cho két qua 1a bao nhiéu?
=ini(8/3)
a. l b. 2
¢.3 d. Bao 1&i
109. Biéu thirc sau cho két qua la gi ?
=*abc” + “cde”
a. Béo 151 b. 6
c¢. “abccde™ d. “abede™
[10. Biéu thirc sau cho két qua la gi ?
= int(-5/-3)
a. |l b. -1
G, 2 d. -2

111. Trong MS Excel, mdt cét co ca 6 chira gid tri s6 va 6 chira gid tri chudi. Khi ta sip xép dit ligu
voi tir khod Ascending thi dir ligu trong cdt s€ dugc :
a %dp \Lp tang dén. thir tr cac gia tri chum trude, sb sau.
b. Sip XCp tang dén, thir wr céc gia tri 50 trude, chudi sau.
! ¢. Chi sap \cp tang dan doi voi 6 kiéu sd (Number).
d. Chi sap xép tang dén dbi voi 0 kiéu chudi (Ie\t)
112. Irong MS Excel, mdt ¢t ¢ ca 6 chaa gid tri s6 va 6 chira gid tri chudi. khi ta sip xép dif lidu
voi tir khod Descending thi thi dur lidu trong cot s€ duge:
a. ‘ﬂp \cp giam dan, thir tu cac gia tri c,hum trude, so sau.
b. Sip xEp giam dén, thir tir cac gia tri so truéc. chudi sau.
c. Chi sip \ep oiam dan dbi voi 6 kiéu sé (Number).
d. Chi sap xép giam dan dm voi 0 kiéu chudi (Text).
[13. Trong MS Excel la o thé sap xép thir tu véi kiéu di ligu:

a. I\lt?u Number. b. Kiéu Text ‘
c. Kiéu Date/Time d. Khong han ché kiéu dir ligu

i 14. Trong MS Excel. gia str dif lidu bang tinh ¢6 c¢6t $8 thir tw (STT) dé sép xép lai bang tinh ma
khéng anh huong dén cot STT la cd thé :

a. Khéi chon phan dor liéu Lan sap \Lp trie cot STT ror thue hién.

b. Khéi chon phan do licu can sdp xép ca ¢ot STT rdi thue hién.

¢. Khong thé sip xép ma khong anh hudng dén cot STT.

d. Sap xép tuy y ma khéng anh huong gi dén cot STT.
115. Ham ¢6 tén la SQRT trong Excel diing dé:

a. Tinh can bac hai. b. Liy phin du ctia phép chia.
¢. Lam won sé. ' d. 1.dy gia tri tuyét ddi.
116. Trong MS Excel | bicu thire =Supper(“LonG An™) cho két qua la:
a. "LONG AN™. b. “Long An™.
c.” long an™. d. Hién thong bdo 16i.
117. Trong MS Excel , biéu thire =Lower(*LonG An”) cho két qua la:
a. "LONG AN™. b. “Long An™.
¢.* long an®. d. Hién théng bao 15i.
118. Trong MS Excel . biéu thire ~Upper(*LonG An™) cho két qua la:
1L ULONG AN b. “Long An™.
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c.* long an® d. Hién théng bao 16i.
119. Trong MS Excel , biéu thire =Proper(“LONG AN™) cho két qua la:

a. "LONG AN™. b. “Long An™.

c.* long an* d. Hién théng bao 13i.

120. Trong excel, dé biét dugc ngdy hién tai trong hé théng may tinh (khéng can hién thi gid, phut,
gidy.. ta st dyng ham ndo trong cdc ham co tén dudi day

a. Date b. Now
¢. Today - d. Year
[21. Trong MS Excel, cho biét gid tri cOa cong thic sau day: =MIN(MAX("57,2),7)
a7 b. Céng thire ¢o 15i
c.5 d. Cau a, b, ¢ sai.
122. Trong MS Excel, ham cé tén 1a ROUND ding dé:
a. LAy phin nguyén ctia sé. b. Lay phan du cta phép chia
¢. L.am tron so. d. Céu a, b, ¢ sai.
123. Gia st & A1 co dif liéu “TT GDTX TN, dé ldy chudi “GDTX” ta cé thé ding cong thic:
a. =Mid(A1.2.4) b. =Mid(A1.3.4)
c. =Mid(A1.4.4) d. =Mid(A1.4.3)
124. Biéu thic sau cho két qua 1a bao nhiéu: =YEAR("2005/06/05")
a. #Name? b. 2005
125. Trong MS Excel cong thirc =INT(13/6.t MOD(3.7. cho két qua la:
a.3 b. 4
[ d. Cau a, b, ¢ sai.
126. Trong Microsoft Excel chon nhom ham chudi gom:
a. Left. Max, Min, b. Left, Right, Mid.
¢. Mid, Mod. Min. d. Value, Int, Round.
127. Trong MS Lixcel, nhom ham co so dir liéu o tén la:
a. Max. Count, Dcount. b. Countif, Sumif, Dmin.
¢. Dmax, Dmin. Dcount. d. Cau a. b, ¢ sai.

Trang 11




CAU HOI TRAC NGHIEM ON TAP MS-POWERPOINT

128. Chon cau sai. Trong khi thlet ké trinh CthU bang PowerPoint:

a. Khdng thé tao chi s6 trén (vi dy sd 2 trong X2) nhu trong MS-Word

b. C6 thé sao chép (copy/paste) mot doan vén ban tr tdp tin Word sang

¢. C6 thé dung WordArt dé tao chit nghé thudt trang tri cho gi4o an

d. Co thé chén cac biéu do vao gido an dién ta
129. Mudn an/hién thanh céng cu trén man hinh soan thdo PowerPoint, ngudi sir dung phai

a. Chon File ->Exit

b. Nhan F1

¢. Nhin Ctrl+ Fl

d. Khong an dugc
130. Chirc nang Animations/ Timing/ Delay dung deé:

a.Thiét 1ap thoi gian chd trude khi slide dugc trinh chiéu

b.Thiét lap thoi gian cho trude khi higu tmg bat dau

¢.Thiét lap thoi gian hoat déng cho tat ca cac hiéu tmg

d.TAt ca déu ding
131. Trong MS PowerPoint, sau khi da thiét ké xong bai trinh dién, cach lam nao sau day khong phai
dé trinh chiéu ngay bai trinh dién d6?

a. Chon Slide Show -> Custom Show b. Chon Slide Show -> View Show
¢. Chon View -> Slide Show d. Nhan phim F5
132. Trong MS PowerPoint. Pang trinh chiéu mot bai trinh dién, mudn ding trinh dién ta nhin phim
a. Tab b. Esc
c. Home d. End

133. Trong MS PowerPoint . Thao tac chon File -> Open la dé
a. Md& mot presentation di co trén dia
b. Tao mdi mot presentation dé thiét ké bai trinh dién
c. Luu lai presentation dang thié ké
d. Ly lai presentation dang thiét ké véi mdt 1én khac

134. Trong khi thiét ké gido an dién (i, thuc hién thao tic chon Insert -> New Slide 1a dé
a. Chén thém mdt slide maoi vao ngay trudce slide hi€n hanh
b. Chén thém mot slide mai vao ngay sau slide hién hanh
c. Chén thém mét slide méi vao ngay trude slide diu tién
d. Chén thém mot slide mdi vao ngay sau slide cudi cing

135. Trong MS PowerPoint, dé chén mot slide mai, str dung t6 hop phim
a. Ctrl + N b. Ctrl + L
c.Crl + M d. Cirl + K

136. MS PowerPoint, thao tac chon Delete Slide la dé
a. Xoa slide hién hanh
b. Xoa tap tin ¢6 ndi dung 1a bai trinh dién hién hanh
¢. Xoa tat ca cac slide trong bai trinh dién dang thiét ké
d. Xoa tat ca cic dbi tuong trong slide hién hanh

137. Trong MS PowerPoint , dé thye hién viéc chén bang biéu vao slide ta phai
4. Chon Table <> [nsert Table b. Chon Table -= Insert
¢. Chon Inscrt -> Table d. Chon Format -> Table
138, Trong MS I’m\enl’mnt. Thue hién thao tac lién quan Animation la dé
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a. Tao hiéu (g dong cho mot dbi tugng trong slide

b. Tao hiéu tmg chuyén trang cho cac slide trong bai trinh dién

¢. Pua hinh anh hoac am thanh vao bai trinh dién

d. Pinh dang cach bd tri cac khdi van ban, hinh anh, do thi ... cho mét slide
139. Khi dang trinh chiéu (Slide Show) mét bai trinh dién, mudn chuyén sang man hinh cia mét
chuong trinh Gmg dung khac (da mo trude) dé minh hoa ma khéng l\c:t thiic viéc trinh chiéu, ta phai

a. Nhan 16 hop phim Ctrl + Tab b. thn lo hop phim Shilt +Tab

¢. Nhén td hop phim Alt + Tab d. Nhén té hop phim Esc + Tab
140. Trong MS PowerPoint Chon phét bi€u sai:

a. Khi tao hiéu tmg dong cho mot khdi van ban ta ¢6 thé cho xudt hién lan luot timg tir trong
khéi van ban khi trinh chiéu

b. Sau khi da tao hiéu {mg ddng cho mot ddi trong nao do ta khong thé thay dbi kiéu hiéu tng
cho ddi twong do

¢. C6 thé thuc hién hiéu tng chuycn trang cho | slide bét kv trong bai trinh dién

d. Co thé thyuc hién hiéu (mg chuyén trang cho tit ca cac slide trong bai trinh dién
141. Trong MS PowerPoint . Am thanh dua vao bai trinh dién

a. Thue hién duge chi khi tao hiéu (mg dong cho ddi tugng trong slide.

b. Thuc hién duge chi khi tao hiéu img chuyén trang giira cac slide.

¢. Thue hién duoc ca khi tao hiéu (mg ddng va hiéu ing chuyén trang.

d. Khang thuc hién dugc ca khi tao hiéu img ddng va hiéu (mg chuyén trang.

142. Trong MS PowerPoint, dé céc slide déu cé tén tdc gia khi trinh chiéu & Footer, ta thuc hién td
hop phim nao sau day?
A, ALTIVEA B. ALTHI+W C. ALT+VH D. ALTHIHI

TRAC NGHIEM PHAN MANG & INTERNET

143. Khi mudn tim kiém thong tin trén mang Internet, ching ta nén
a. lim kiém trén cac Websites tim kiém chuyén dung
b. Tuy vao ndi dung tim kiém ma két ndi dén cac Websites cu thé.
¢, Tim kiém & bét ky mot Websites nao
d. Tim trong cic siach danh ba internet
[44.Chac nang Bookmark cia trinh duyét web ding dé:
a. Luu trang web vé may tinh
b. Panh diu trang web trén trinh duyét
c. Dat lam trang chu
d. Tat ca déu ding
145. Chon phat biéu chinh xac nhat vé mang ]ntcrm.t’
a. La mang cta cac mang, ¢6 quy mo toan chu
b. La mang st dung chung cho moi ngudi, cd rat nhiéu dir liéu phmw phi
¢. La mang c6 quy md toan ciu hoat ddng dua trén giao thic TCP/
d. L.a mdi truong tr uyén thdng toan cdu dua trén ki thudt mdy tinh.
6. WWW [a viét 1at coa cum tl ndo sau ddy?
a. World Wired Web b. World Wide Web
c. World Wide Wed d. Windows Wide Web
147. Phat biéu nao vé website dudi day la phit hop nhét?
a. LA mot may cha cung cip dich vu web
b. La m6t trang chu
¢. La mét hodc n hiéu trang web dugc t6 chire dudi mot dia chi truy cap
d. La mot hodc nhiéu trang web ciia cling mot 1 chic
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148. Chon phat biéu sai:
a. Mdi may tinh tham gia vao mang phai co dia chi duy nhat, duoc goi la dia chi IP.
b. Nguoi ding lam viéc véi dia chi IP ca dang s6 va dang ki tur
¢. May lam vi¢c vdi dia chi IP dang 50 con ncum dung chi lam viéc vai dia chi 1P dang ki tu.
d. Dia chi IP dang ki tu (tén mién) cd thé gbm nhiéu truong cach nhau boi dau chém.
149. Pé dang ki hop thur dién td nguoi ding cé thé str dung nha cung cip dich vu:
a. GMAIL b. HOTMAIL
c. YAHOO d. Céc céu trén déu ding

150. Trong mot hé théng mang ndi bo ngang hang (Local Network) st sung h¢ diéu hanh Windows
(XP)de duné, chung mot may in thi:

a. T4t ca cdc may tinh trong mang phai dugc cai dat trinh diéu khién thiét bi (Driver) cho mdy
in do.

b. May tinh két ndi truc tiép voi may in phai dugc cai dat trinh diéu khién thiét bi (Driver) cho
may in do

c. May in phai duoc chia s¢ (Share) quyen truy cép.

d.Ca2y:bvac.

[51. Phat biéu nao dudi day vé trang web tinh la chinh xac nhat?
a. La trang web chi chira ndi dung van ban
b. La trang web khéng chida hinh anh dong nhu doan phim video
¢. L.a trang web khong cé kha nang tuong tac voi ngudi ding
d. [.a trang web khdng cung cép chic nang tim kiém
132, Trang chu (Ilomepage) la:
a. Trang web hudng dan su dung website
b. Trang web dau tién duoc mé ra khi truy cip website do
c. Trang web cua ca nhan
d. Trang web ma nguoi dung dang nhin thiy.
133.Mang Ineternet ra déi vao nam nao?

a. 1963 b. 1969 c. 1978 d. 1984
154, Dich vu Ineternet duoce chinh thic cung cdp tai Viét nam vao nam nao?.
a. 1986 b. 1990 c. 1997 d. 2000

155, Arpanet a7
a. Tién than cua Internet
b. M6t chuan mang cuc bd (LAN)
¢. Mot chudn mang dién rong (MAN)
d. Ma hinh phan ting
156. Muc dich chinh ctia viéc dua ra tén mién
a. D¢ nhé
b. Tén mién dep hon dia chi IP
c. Thiéu dia chi IP
d. Tén mién dé xir ly bai may tinh hon
157.Mudn sir dung thu dién tir trwde hét phai:
a. Dang ky mot tai khoan thu dién o
b. DPang ky mdt tai khoan Internet
¢. Comot hom thu ca nhan
d. Cé mét chuong trinh nhén/gui thudién tir
158. Mubn mé hop thu da 1ap phai:
a. Cung cép chinh xac thdng tin tai khoan di dang ky cho médy cha thu dién tir
b. Ding ky mét tai khoan thu dién tu
¢. Co chuong trinh nhan/eui thu dién tu
d. Cung cép 1ai khoan st dung Inlernet
159. Khi mot dong chii d& trong thu ta nhan duge bt ddu bing chir RE: | thi thong thudng thu 14:
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a. Thu réc. thu quang cio

“b. Thu méi
c. Thu tra 1oi (cho thu

ma ta da guri) (o mét ai do

d. Thu cuia nhé cung cép dich vu E-mail ma ta dang sir dung

160. D& chuyén tiép thu, dur
a.Relpy

12 nat
b.Relpy to All ¢.Forward

HET

d. Attachment
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Chu | Pap an| Cau | Dap an | Céu | Pip an Cau | Dap an
L a | 46 a 91 ¢ | 136 a
2 d |47] d 92 b |137]| ¢
3 b | 48 ¢ 93 b |38 a
4 49| ¢ | 94 a | '139] ¢
5 a 50 b 95 o 140 b
6 ¢ |51 d 96 | d |141] «c
7 a | s52] d 97 c |142] ¢
8 | ¢ [53] d 98 d |143] a
9 b 54 C 99 a 144 b
0| ¢ |55 b [100] ¢ [145] ¢
11| a |56] b |10l b |146]| b

g d 57 a 102 a 147 c
13| a |[358] b 103 d |148] ¢

14| d |59 d |104| ¢ |149] d

150 b 60| d [105] a [150| d

16| b [é6l c 106 d 151 c

M7 b Lo c 107] d [152] b
18] ¢ 30 b [108] b [153] b
19 ¢ 64 d 109 a 154 C
20 b |65] ¢ 10| a |155| a
21 d [66] b |11l b [156] a
22 b | 67 & 112 a 15 a
23] d [68] b [113] d [158] a
24 b [69] b |114] a |159] ¢
251 b |70 b [115] a [160] «¢
26| d |71 ¢ 16| d
271 a4 [72] b |117] ¢

28 ¢ || d [118]| a
29 ¢ [74] b [119] b
30 b [75] b [120] ¢
31 d [76] b |12l ¢
2] ¢ |[77] b [122] ¢
33| a | 78] b 1231 ¢
| d [79] d 124 b
35 d [80] ¢ 125 ¢
36| ¢ [81] a [126] b
37 b |82 ] b 127 ¢
381 ¢ | 8| ¢ |128] a
39 b | 84| a 129 c
40 d |8 ] ¢ 130 b
41| d |8 d 131 a
21 ¢ [82] b [132] b
43| a [88] b |133] a )
44 b |89 134 | b
45 b ]90 135
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